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Recording Your Audio and Creating Your MP3 File using Audacity
Many people who are working with digital audio are choosing a program called Audacity for many reasons:

It has an easy learning curve.

It has advanced features for those who want them.

It is free.

It is cross platform. Essentially what you see on the PC is what you see on the Mac.
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You can download Audacity at this address:

http://audacity.sourceforge.net/

There are Windows, Mac OS 9 or X, and Linux/Unix versions available. You will also have to download the LAME
MP3 encoder “plug-in” that allows Audacity to export MP3 files. You will see the download link for that on the
same page as the Audacity download.

Opening Audacity

When you launch the Audacity application you will see the following window.
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This is a typical window. You can see the controls for playback, recording and simple editing of the sound that you
record.

The main record and playback controls from left to right are:

¢ SKkip to start

¢ Play

* Record
* Pause

e Stop

¢ Skip to end

Hint. If Audacity appears to be “hanging” or the menus are unavailable simply check you have clicked the stop
button at the end of playback. Or, simply click the Stop button

When you initially launch Audacity the window is blank. Do not allow that to concern you. All applications
commence with a blank page or slate. See the example on the next page.
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Audacity
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Disk space remains for recording 43 hours and 7 minutes
Project rate. 44100 Cursor: 0000 000000 mircsec  [Srap-To OfY]

Setting preferences

It is wise to set the Preferences at this point. Go to the File menu and select
“Preferences”. See the window at right. EdE View Project Generats Effect @

Hew Ctrl+N

Open. .. Cerl0
Close Chrly
Save Projeck trl+5

Save Project As...

Expork As WAY...

Export Selection &3 Way...

Export As MP3...
Export Selection As MP3..

Expark As Qgg Yeorbes, ..
Export Selection As Ogg Yorbis...,

Export Labels...
Export Mukiple, .

Page Setup...
Frint...

Please note that on the Mac OSX version of Audacity the Preferences Audacity File Edit
menu is available in the Audacity menu.

About...
Preferences... %,
Services >

Hide Audacity 8H
Hide Others " #H
Show All

Quit Audacity #Q
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When the Preferences window appears make sure you have selected the correct hardware choices for sound playback
and sound recording on your computer.

'aXala Audacity Preferences

{-MW Quality | File Formats = Spectrograms = Directories  Interface  Keyboard =~ Mouse L

Playback
Dewice: | Built-in Audio |.g.]
_Recarding
Device: | Built-in Audic )

L]

Channels: | 2 (Stereo)

z Play ather tracks while recording new one
: Hardware Playthrough (Play new track while recording ith

[ software Playthrough (Play new track while recording it)

(: Cancel _:1 -I:-_ OK :)/:

You can also check to see if the default input source is selected using the drop down menu on the Audacity toolbar.
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Recording your voice
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Check that the microphone is working and simply click on the Record button on the toolbar. When you have finished
the recording click on the Stop button. You can then review and even edit your voice recording.

You can click the green playback button to review the recording. Its relative volume will appear in the volume level

bars. See below.
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The completed recording will look like this. At the beginning of the track is a small control panel that allows you to
mute the track, split it into a stereo track from a mono track, change its sample rate and also simply delete the
entire track by clicking on the “X” close box in the top left corner of the track. You can also alter the volume of the
track and whether or not it pans left channel or right channel in your project. More on the control panel below.
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The waveform represents the relative volume and the modulation of your voice. If you select part or all of this track
you can copy, paste, edit, delete and apply filters to the track. In this case we have one single track and it is a mono
or single track channel.

Remember to save your Audacity project early and often.
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Importing audio

In addition to recording your own voice you may choose to import audio from another source. To do that simply
choose Import Audio from the Project menu.

Generate Effect Analyze Help

@ Import Audio. .. Chrl+I
- Import Labels...
K | Import MIDL... -
| Import Raw Data... =
I~ Edit ID3 Tags... 3
% Quick Mix ==
T
OHZ  mew Audio Track

Mew Stereo Track
plo Mew Label Track
| ¥ Mew Time Track

R Remove Tracks
Align Tracks...

Align and move cursor. ..

Add Label At Selection Ctrl+B
Add Label At Playback Position  Ckrl+M

A window will open and you should browse your folders till you find the audio file that you wish to import.

Select one or more audio files...

Look in: | ) Background_Music_Loops > - @B
() AMBIENCE 4] NATURE
L3 A EXOTIC! ) TRANCE
MyRecent |4 FUNTIMES ] WORLD

Documents _éj Introduction_01

@ ) Introduction_02
A azz
Desktop || Loop_p1

N AL00P_01
) 4 100P_02
' A LOOP_T1
HaD A MEMORI1
) MEMORIZ
g’ 2 MooD
My Computes

g File name: | _:] Open I
My Network  Files of type: | Al fies ) ~
Places v
v Open as read-only
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The imported audio file will become a track in your Audacity project window. See below.

& Audacity r:_'ﬁ|g
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Dk space remans for recordng 43 hours and 8 metes
Project rale. 44100 Curgor: 000000000 mincsec [Snap-To O]

In the example above you can see that the imported audio track called “Ambience” is a two channel or stereo track.
It has a higher volume than the single channel voice track and its duration is also longer than the voice track.

You can edit both of these tracks to meet your needs.

Audio Track Control Panel

g[cﬁlfr :Celg(glnmng of each track is the control panel. You can use this control panel to name x| Audio Trac ¥
' Mono, 44100Hz
32-bit float

Mute | Solo
In addition to that you can adjust the position of the track’s sound output by panning the _ o
sound to the left or to the right. For example, you may pan an interviewer to the left channel '4@—'
and in a separate track pan the respondent’s voice to the right channel. L R

You can also adjust the overall volume of the entire track by adjusting its gain.

You can also temporarily mute or silence the track. Alternatively, by selecting the Solo button
you can make that specific track the sole track that is audible, temporarily muting all others.

You can also delete the track by clicking on the “X” in the top left corner of the control panel.
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Frequently used tools

When editing your tracks there are several tools and menu items that you will use quite often. Let’s look at some of
these tools and menu items.

Selection tool

This tool allows you to select tracks. It must be selected in order to edit audio tracks. See below.

Iiﬂ Edit Yiew A
II=¢

JIpuap

It allows you to select and highlight a portion of the audio track. See the example above.

You could then delete, copy or apply filters to that selected portion.

Timeshift tool

This tool allows you to shift individual tracks backwards and forwards in time in relation to the entire audio project.
You might wish to have sound effects and background audio tracks appear at specific points in the project. See
below.
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In the example above the first audio track is at the beginning of the audio project. Track two commences half a
second later and track three commences one and a half seconds into the project.
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Envelope or “rubber band” tool

This tool is very useful for adjusting the relative volume of the track at various points throughout the duration of the
track. You can create fades and even silence part of the track.
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When you select this tool a pair of blue parallel lines appear at the top and bottom of the track. You can set points at
various points on these lines and then click drag on the lines to adjust the relative volume of the track. See the
example above. These envelope lines are sometimes called rubber bands.

- ——

b

Frequently used menu items
View menu
When you have created a number of audio tracks the project window begins to fill up and overflow with audio

tracks. You may find the need to scroll up and across to see all parts of the track. If you wish you can utilize the
View menu to see the entire project. See below.

N Project  Generate Effect  Analy

Zoom In Chrl+1
Zoom Mormal Ctrl+2
Zoom Out Chrl+3
Fit in Window Ctrl+F
Fit Yertically Ctrl+Shift+F

Zoom ko Selection Ctrl+E
Set Selection Format 4
History...

Float Control Toolbar
Float Edit Toolbar
Float Mixer Toolbar
Float Meter Toolbar

You can use the View menu to fit all the audio tracks in the project window (“Fit in Window”) as well as fitting all
the tracks in the project window vertically (“Fit Vertically”).

You can also zoom in or out of the project and specific tracks for a closer view of the track as your perform detailed
editing.
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Edit menu

The edit menu is another that you will use often, particularly if you do not use keyboard shortcuts for copy, cut and
paste. See the menu below.

m View Project Generate B You can use the Edit menu to perform basic functions such as undo, cut,
copy and paste. You can also select a portion of track and apply the
Undo Delete Ctrl+2 following changes:
Redo Split Chrl+Y
You can cut, copy and paste selected portions of tracks.
Cut Chrl+¥
Copy Ctrl+C You can trim or remove the sections of the track that precede and
follow the selected portion of the track.
Trim Chrl+T . .
You can delete a selected portion of the track and remove it from
Delete Chrl+K the project.
SHence ekl You can silence a selected portion of the track.
D licat Ctrl+D You can duplicate a piece of track. The duplicated section will be
UpRCaS e copied to a new track.
Select... »

You can split a piece of track. This is useful. The selected piece of
track is removed from the original and placed in a new track
immediately below. See the description and screen shots below.

Find Zero Crossings 2

Selection Save

Selection Restore Preferences. You can use this menu to determine the source of
your audio input and the speakers that you will use for your
output. You can also set other parameters including the final sound
Snap-To... 4 quality of your published project. On the Mac OSX version of
Audacity the Preferences menu is available in the Audacity menu.

Move Cursor... >

Preferences... Ctrl+P

Effect menu

This menu has a range of effects, many of which you will not use as the primarily apply to synthesizer, midi and
electronic music sources. However, you will find effects such as Change Pitch, Change Speed, Amplify, Echo, Fade
In, Fade Out and Reverse useful in applying effects to voices. These effects can allow a single user or multiple users
to create a range of “characters” for their audio project.

E Analyze Help

Repeat Invert &R

Normalize...

Amplify... Nyquist Prompt...

Bass Boost... Phaser...

Change Pitch... Repeat...

Change Speed... Reverse
Wahwabh...

Change Tempo...

Click Removal... Cross Fade In

Compressor... Cross Fade Out
Echo... DC Bias Removal
Equalization... Delay...

Fade In Fade In

Fade Out Fade Out

FFT Filter... High Pass Filter...
Invert Low Pass Filter...

Noise Removal...

Tremolo...
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Splitting tracks
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You can split a piece of track using the Edit menu. This is useful. The selected piece of track is removed from the
original and placed in a new track immediately below. See the description and screen shots below.

View Project Generate B

Undo Delete Ctrl+2
Redo Split Chrl+Y
Cut Chrl+¥
Copy Ctrl+C
Paste Chrl+y
Trim Chrl+T
Delete Chrl+K
Silence Ctrl+L

Track before the spilt

Duplicate

Ctrl+D

Select...

Find Zero Crossings 2

Selection Save
Selection Restore

Move Cursor...
Snap-To...

Preferences...

Ctrl+P

RCR) ev-nc-sh |

Track after the split. Note that a new track has been created.
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Exporting your project as an MP3 file

£ Audacity
Wheq you have ﬁnlshéd creating your .audlo proj ect you can export the S Edit View Project Generate Effect 4
track in a number of different formats including mp3. To do that select
Export as mp3 from the file menu. See right. e Qi
Open... Ctrl+0O
Close Crl+w
Save Project Ctrl+35

Save Project As...

Recent Files... »

Export As WAVY,..
Export Selection As WAaV...

Export &s MP3...

Export Selection As MP3...

Export As Ogg Yorbis. ..
Export Selection As Ogg Yorbis...

Export Labels. ..
Export Multiple. ..

Page Setup...
Print...

Exit

You will be asked to save the file as with any save file process. See the window below.

Save MP3 File As: (2 %]
Save I@Desklop L] & @ ¥ ED-
a )My Documents
'_j My Computer
My Recent  WJmy Network Places
Documents | 1J paralels Shared Folders
6 |_Podacst Test
Desklop
My bocunen!s
My Computer
My Netwoek  File name: podcast mp3 v Save
i l G
Save as lype: MP3 fles [“mp3) v ancel
I ( = |

RCR) ev-nc-sh |

Some rights reserved http:/ / creativecommons.org/licenses /by-nc-sa/3.0/



http:/ /blog.larkin.net.au/

Page 12

When exporting an mp3 file for the first time the Audacity software asks you to locate the Lame MP3 encoder

software. Locate the plug-in on your computer. See below.

Where is lame_enc. dlI?

2

Lock jrc [ ) lame-396.1 | & @ cFE-
D |G
bl
My Recent L)misc
Documents Ellame_enc.dll
Deskiop
My Documents
iy Computer
" File rame: [Im_mr: .ﬂ IELI
MyNetwerk  Fies ofype:  [Orly lame_enc. 5] Cercel |
aces
I Open a3 read-only

i

set of relevant information tags or descriptions that your students or audience will understand.

3

Edit the ID3 tags for the MP3 file

Format;
1031 [more compatible)
(o |D3v2 [more flexible)

Title: |Tut|:|rial problem 01

Artizh: |h-1 FE

Album: |Briu:|ge Caonztruction

Track Mumber: |01 Year |2004

El

Genre: | Heawy Metal

Commerks: |F'EL Exercize

ak.

Cancel |

Save your file in an appropriate directory. Remember where you saved the file.

() &v-nc-sh |

Once you have installed the plug-in you will then see the following window. You can name and give your mp3 file a
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Save MP3 File As: ? %]
Save i [ (@ Desktop ~| & @ exER-
My Documents
@ ' My Computer
My Recent  &Jpy Network Places
Documents | 13 parallels Shared Folders
@ ()Podacst Test
Desklop
',
y
My Documents
My Compuiter
My Network  File name: podcast mp3 v Save
| = sae |

Save astype:  |MP3 fles ["mp3) ~| Cancel |
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